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Please read all of this document - it's important! Really!


We've tried to make this readme file informative, useful and fun. 
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I. Reading this Document





Using Write:


To make this document easier to read, enlarge the Write window by clicking the Maximize button in the upper-right corner of the window. Or open the Control menu in the upper-left corner of the Write window (press ALT+SPACEBAR), and choose the Maximize command.





Make sure that you are in Portrait Orientation. To check, open the File menu and select Print Setup.... Click the Portrait button if it's not set.





Use the Find menu to search for information which may be of interest to you. Readme files are the last chance for producers, programmers, managers, testers and other nefarious types to include important information. As such, information can be a little "scattered". Search (with Find) and you may be pleasantly surprised. It ain't hyper-linked text, but it's the next best thing.





To move through the document, press PAGE UP or PAGE DOWN. Or click the arrows at the top and bottom of the scroll bar along the right side of the Write window.





To print the document, choose Print from the File menu. 





For Help on using Write, press F1.





NOTE: The screen shots in this Readme file are in 16 color BMP files to keep this file as small as possible. Also, the screen shots may not look all that spiffy when printed. Believe me when I tell you that the game looks much better in 256 colors. 





Using Something Other Than Write:


This document has been written using an outline structure. Unfortunately, Write doesn't support an outline structure.





If you can load this document into another word processor that CAN display it in an outline, you'll be able to find help and information more quickly by reading subject headings.





Actual Read Me information starts here...





II.Technical Stuff





Introduction:


Games are pushing the envelope of software development. Word processors and spread sheets, for all their menus and functions and what not, mostly just sit in memory and wait for you to do something. Games are running all the time, grabbing resources and forcing graphic drivers to perform at peak level. Full Tilt! may be "just a game", but it's a busy game, and it's making your system work all the time... even when the window is minimized.





If you're having trouble running Full Tilt for Windows, or are getting error messages, check out this section first (it's why we put it near the top of the file.) These tips were compiled and written by the Virtual Adept Magus of Maxis Customer Support and QA., and contain enough information to make you an expert too (or at least sound like one).





System Conflicts:


Conflicts are rare but they can occur. If you're not having problems, take no action (or, if it ain't broke, don't fix it.)





If you are having problems (or if the fine writing in this file seems interesting), read on.





Many people make Windows load some programs automatically. Some of these programs are benign. Others are resource hogs. The easiest solution is the most drastic: turn off everything but the Program Manager (Win 3.1) and Full Tilt! to free memory and system resources.





If that's a bit much, consider that most problems are caused by two types of programs. The worst offenders are screen savers. If you're using a screen saver (even the default Windows screen saver), you should disable it to prevent conflicts when running Full Tilt!.





The second worst offenders are virus protection programs. It's a sad comment on our times that virus protection programs are a necessity, but really, the only time they actually do any good is when a disk is inserted. There's no reason to have them running if all you are doing is playing a pinball table. If you experience trouble running Full Tilt! for Windows, try disabling virus protection programs. 








To determine if something else is running, hold down the {Ctrl} key then press {Esc} keys on your keyboard at the same time. This brings up the Windows Task List in Windows 3.1.





Ideally, the only item in the Task List window should be Program Manager. If there are any other items shown, and you want to disable them, click on the item to highlight it and click on the End Task button to turn it off. Repeat until only Program Manager is active. Now run Full Tilt! for Windows.





Uninstalling FullTilt in Windows 95:


To remove FullTilt from your hard disk, use the Add/Remove Programs program found in the Control Panels folder. UnInstall will remove everything that the SimCity 2000 installer has put on your hard disk, including registry information, program files, and menu icons. However, if you have saved any new files (as opposed to saving over files that were installed by the setup wizard), those files will not be removed and the SimCity 2000 program directory will not be erased. The UnInstall program will warn you if there were any files left behind.








III. Some Other Things To Consider





Windows Shells other than Program Manager:


Shell programs are third party replacement programs that you can use in place of the standard Windows Program Manager. These include such things as HP Dashboard, the Norton Desktop, and XSoft's TabWorks (which comes installed on most Compaq computers).





If you are having trouble installing or running Full Tilt! for Windows, try either turning off the shell you are using, or using that program's File - Run command to run Program Manager. The command line to run Program Manager is C:\WINDOWS\PROGMAN.EXE. Once you have installed Full Tilt!, you should be able to close Program Manager and run Full Tilt! through the shell program you usually run.





Some shell programs simply won't let you run Full Tilt! properly. If you have successfully installed Full Tilt! but it still won't run, try turning off the shell program you have been using.





A Special Note About TabWorks: If you are running TabWorks, we STRONGLY recommend the following procedure to eliminate extraneous icon creation and other bizarre problems.


1. Go to the Options menu.


2. Select File Tracking Options, and deselect Track File Creation and Track File Modification.


This will allow you to install Full Tilt! through TabWorks without having to run Program Manager.





QEMM, 386MAX. and other "cloaking" or "shadowing" memory managers.


QEMM has a feature called "Full Stealth Mode". Full Stealth Mode tries to free as much lower memory as possible by "cloaking" or "shadowing" all the devices and drivers in upper memory. This would include most video cards BIOS. We recommend that you turn off Stealth Mode altogether or do not include the Video Regions in the optimization of your system. If you need any assistance with these procedures PLEASE call the manufacturer of your memory manager to confirm that what you are using is WinG compatible.





Increase Resources:


If you get occasional General Protection Faults in MMTASK or MCISEQ, try increasing the buffers allocated for sounds. To do this, open the Control Panel icon and select Drivers. In the Drivers window, there will be a list of items like "Timer" and "[MCI] Sound". Highlight "[MCI] Sound", and click on the Setup button. Usually, the MCI Waveform Driver Setup window will be configured for a 4 second buffer. You should try increasing that to 6 seconds.





Be Bold!:


When all else fails, increase the amount of low memory available in DOS. See your DOS manual for information on increasing the amount of memory available.





IV. Sound , Music and Video


Sound / Music:


There is no music in Full Tilt!.





Full Tilt! for Windows supports all sound cards that are compatible with Windows 3.1 and Win95. If you do not have a sound card, you will get a message reminding you of this. Click "Continue". Full Tilt!  will run without sound.





If you have a sound card, check the Options menu in Full Tilt!. In the Options menu are two items called Sound and Music. For sound to play, at least one of these menu items must be selected. Having both gives you the full range of sounds in Full Tilt!. Turning off both gives you more speed from your computer.








General Protection Faults (GPF):


"Full Tilt! has caused a GPF in module WAVMIX16.DLL"


Full Tilt has caused a GPF in module MM16.DRV


If you receive these error messages you will want to update your sound card drivers directly from the manufacturer.  Even if you bought your computer today it still may not have updated drivers.  In you documentation for your sound card you should find a Technical Support phone number to call to request new drivers.  These are usually free of charge to registered users of the hardware.  





"Full Tilt! has caused a GPF in module MAD16C.DRV"


If you receive this error message you have a Turtle Beach sound card.  Contact Turtle Beach and request their most recent drivers for your sound card.





If you do not know the manufacturer of your sound card, then contact the manfacturer of your whole system they can also provide you with the information you need.  If you do not know the name of your system manufacturer contact the person or dealer that sold you the computer.  They should be able to help you get more information











Sound Blaster 16 Sound Card Problems


Some users have reported problems using the Creative Labs Sound Blaster 16 sound card with Full Tilt! Pinball for Windows and Windows 95. Problems include choppy sound effects and/or music, MIDI errors, skipping and cutting out. Unfortunately, the Sound Blaster 16 sound card has been known to have some difficulty playing MIDI and .WAV files simultaneously. The best thing to do if your Sound Blaster 16 starts acting up in Full Tilt! is to aquire the latest drivers for the card. Just contact Creative Labs at the number provided in your Creative Labs Sound Blaster 16 package. If that doesn't do it, then try disabling the sound effects and just play music, or vice versa.





General notes on Video cards:


The Most Important Video Information In This File


Some video drivers shipped with Windows 3.1 do NOT work on most systems. These drivers are designed to work only with specific video cards. Chances are that you do NOT have this type of card! These are the drivers which begin with Video 7 or XGA.





If you use these drivers but don't have the cards they are designed for, you'll get a blank screen when Windows loads. Windows is actually running just fine, but it's kind of hard to use a graphic interface if you can't see the graphics.





If you are reading this after you have already loaded one of these drivers and you no longer can load up Windows, call your video card manufacturer.  If you have any doubts about changing your display drivers around PLEASE, call your video card manufacturer.





V. Using Virtual Memory


Disk Compression Users:


If you're using disk compression software such as DoubleSpace, DriveSpace, Stacker, SuperStor or things like that, these instructions ARE NOT for you. Most of these programs will come with their own utilities to use virtual memory. Refer to the documentation that came with your compression program for more information.)





Non Disk Compression Users:


If you don't have enough memory to run Full Tilt! for Windows, first close all other programs that are running to free up the necessary memory.





If this doesn't correct the problem, there's still hope. To prepare yourself, you might refer to the Windows manual section called MEMORY. There are several different options explained in the manual, from editing your startup configuration files to using Virtual Memory. We can help you out a little here (and we're somewhat less daunting than the Windows manual).





Virtual Memory uses your system's hard disk drive to temporarily store information that would normally be kept in the system RAM memory. It's a little slower than RAM, but you have the potential to increase your available memory quite significantly.





You run Virtual Memory by following these steps:





1. Find your Control Panel icon. It's usually within the Main program group.





2. Double-click on the Control Panel icon to open it.





3. Double-click on the Enhanced icon (the icon looks like a computer chip -- if it is not there, you are not running Windows in Enhanced Mode. See the instructions on starting Windows in Enhanced Mode.)


4. Click on the Virtual Memory... button to open the Virtual Memory window.


5. Click on the Change button. You'll get a window which has some important information. The most important information is the Recommended Maximum Size for Virtual Memory on your computer. This number will vary from machine to machine. If you're computer is not already set to this number, you're in luck. Type that number in the New Size box.


6. Check out your Windows manual for more information concerning virtual memory.





Finally, if you are using Sound Effects Full Tilt! for Windows, you will need as much free conventional memory as possible. Conventional memory is memory below 640k. Please see your DOS manual for instructions on freeing conventional memory. If you have DOS 6 or higher, just run the MemMaker program. Type MEMMAKER {Enter} at your DOS prompt.  Then choose the "Express" setup, and say "NO" to "Do you use any programs that require Expanded memory?"





VI. How to Reach Maxis Technical Support





What You Should Do Before You Call Technical Support:


Before you call Technical Support, please be sure that you have read this Read Me file and any other appropriate material. When you are at your wit's end, scratching your head and grumbling, read on to find out what we would like you to have ready when you call, so that we can get you running as quickly as possible.  It will save both you and our overworked technicians lots of time and aggravation!





What You Should Have With You When You Call: 


1.  Have a print-out of your WIN.INI and SYSTEM.INI files as well as your CONFIG.SYS and AUTOEXEC.BAT files.  You can easily print all of these files by typing MSD {Enter} at the C:\ prompt.  This will run the Microsoft Diagnostics program which will allow you to print out a report of your system.  If you can't print out your system files (you don't have a printer), it isn't the end of the world, as long as you are at your computer when you call!  Make sure that your computer system meets or exceeds the requirements defined on the SimCity 2000® system label.  The system label is located in the lower-left portion on the front of the box.





2.  If you are getting error messages or General Protection Faults (GPFs), write down exactly what the error message says.  That will help us diagnose the problem.





3.  Write down all of the steps you have taken to solve the problem.  If we know what you've already done, we may be able to get you running faster.





 4.  Have your program disks, your manual, and your Addendum available and within easy reach.





Where You Should Be When You Call:





Please, please call us from your computer!  We need to have you at your computer to explore your system to identify what is causing your problem.





Let's Do the Numbers:





There are a number of different options that you can use to contact Technical Support. The first is by telephone, but this may not be the best option for you.  If you decide that you would like to call and hear a friendly voice, you'll find the number and hours of operation for Technical Support listed on the Maxis Maxims sheet, included in the box your program came in. There is lots of other useful info there, so keep your Maxis Maxims somewhere handy.





We are present on all of the major on-line services if you subscribe to any of these. If you don't currently subscribe, many on-line services will give you a 30-day trial membership.  Refer to the Maxis Maxims for more information on signing up. On AOL, just e-mail to "Maxis", or use keyword "Maxis". On CompuServe, do "GO GAMBPUB" and leave a message in the Maxis forum.





NEW! Internet users! We can be reached on the Internet via e-mailing to SUPPORT@MAXIS.COM.





We also have a new Web Page. Point your browser at http://www.maxis.com/





If you have a modem, on-line support is often a better option for you.  We maintain a BBS that is free-of-charge (excluding long distance charges from your phone company) to all registered users of Maxis products.  The BBS number is (510) 927-3869 and it is available 24 hours a day, 7 days a week.  We support up to 14.4k bps and have four nodes. The settings are 8-N-1.  You can also find the latest FAQs (Frequently Asked Questions), hints and tips from other users and other good stuff.


